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1 OVERVIEW

The NuEclipse is designed for cross-platform embedded ARM development. It includes a series of
Eclipse plug-ins and tools. The plug-ins allow the user to create, build, and debug ARM-based projects
within the Eclipse framework. Its features are listed below:

® Creating projects by the New Project Wizard: The New Project Wizard provides several
templates for different target chips.

@ Building projects by the GNU ARM Toolchain; The toolchain contains the ARM Embedded
GCC compiler. The user can use it to build projects without restriction.

® Debugging projects by GDB: The user can halt, step, run, and monitor target chips.
Accessing memory and flash is allowed. Setting hardware breakpoints and watchpoints is
supported. In addition, the user can erase target chips and program the user
configuration.

Through the NuEclipse, the user can develop projects of the NuMicro® Family within the Eclipse
framework.

1.1 Supported Chips
To see the list of supported chips, please refer to Supported_chips.htm in the folder of user manual.
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2 REQUIREMENTS
The following table lists system requirements for the user to run the NuEclipse.

Minimum Requirements Recommended Specifications
Operating System Windows®7 x64 or GNU/Linux Windows®10 x64 or Ubuntu 18.04 LTS
GNU ARM Embedded Toolchain | 6-2017-g1-major The latest version

Note: To have a fully usable and pleasant experience on Linux, the recommended Linux distribution is
Ubuntu 18.04 LTS (64-bit).
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3 QUICK START

3.1 Installation
To make the NuEclipse ready for work, perform the following steps based on your operating system:
1. Performing the NuEclipse installer on Microsoft Windows.

2. Extracting the NuEclipse tar file on GNU/Linux.

3.1.1 Performing the NuEclipse Installer on Microsoft Windows

On Windows, it is very easy to install the NuEclipse only by performing the NuEclipse installer. The
installer will ask the user to install the GNU ARM Eclipse Windows Build Tools and GNU ARM
Embedded Toolchain because they are required by NuEclipse.

1%, MNuEclipse_V1.01.017 Setup

Welcome to the
NuEclipse_V1.01.017 Setup Wizard

This wizard will guide you through the installation of
MuEdipse_¥1.01.017.

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Mext to continue,

Figure 3-1 NuEclipse Setup Wizard
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3.1.2 Extracting the NuEclipse Tar File on GNU/Linux

On GNU/Linux, it is very easy to install the NuEclipse only by extracting the NuEclipse tar file. After that,
run the install.sh script to complete the installation process. Please do not use the sudo command to

run the script.

1t Home Desktop  NuEclipse_V1.0...g_Linux_Setup  UserManual

© Recent Name -~  Size Modified
@ Home erclipse 15items
[ Others 4items
[ Desktop [ userManual 3items Yesterday
D Documents
= uninstall.sh 501 bytes 21Mov 2018

v Downloads

Figure 3-2 Install.sh Script
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3.1.3 Verifying the Eclipse Preferences

After the installation, the Eclipse preferences are automatically written on Windows. To verify them, click
Window > Preferences, the Preferences wizard appears. Go to C/C++ > Build > Global Tools Paths
and make sure the Build tools and Toolchain folder be correctly configured to what the installer has
installed in the previous step. Click the Apply button to take effect. On GNU/Linux, Build tools folder
path is not required. The path should be empty.

= Preferences a X
type filter text | | Global Tools Paths CR A
General ~

The locations where various GNU ARM Eclipse tools are installed. Unless defined more specifically, they are used
C/Cr+ for all projects in all workspaces.

Appearance
Autotools Build tools folder: | C:\Program Files (B6)\GNU ARM Eclipse\Build Tools\l.S—ZﬂlﬁllZl‘lQlS\bil [ Browse... I

+ Build Default toclchain: | GNU Teols for ARM Embedded Processors ~
Build Targets
Build Variables Toolchain name:  |[GMU Tools for ARM Embedded Processors
Console Toolchain folder: | C:\Program Files (x86)\GNU Tools ARM Embedded\6 2017- gl -update\bin Browse...

Environment
Global Tools Paths
Logging
Makefile Editor
Settings
Workspace Tools Patk
CMake
Code Analysis
Code Style
Core Build Toolchains
Debug
Docker Container
Editor
File Types

Ind
neexer v Restore Defaults Apply

2 R i @ Apply and Close Cancel

Figure 3-3 Preferences for Global Tools Paths
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Subsequently, go to Run/Debug > OpenOCD Nu-Link and make sure the OpenOCD folder be
configured to where the installer has put the OpenOCD executable. On Microsoft Windows, for example,
the path of OpenOCD folder could be C:/Program Files (x86)/Nuvoton Tools/OpenOCD. Similarly, on
GNU/Linux it could be /usr/local/OpenOCD. The OpenOCD executable provided by Nuvoton is
customized for Nu-Link. If the user tries to use other OpenOCD executable, OpenOCD and Nu-Link may
not cooperate well. Click the Apply button to take effect.

‘s Preferences O x

|type filter text OpenOCD Nu-Link G- 8
Property Pages Settin A
Qt
Task Tags
Template Default Vali
Changelog Folder: | C:/Program Files (x86)/Nuvoton Tools/OpenQCD/bin Browse...
Docker
Help
Install/Update
Library Hover
Mylyn
Oemph

Configure the location where OpenOCD for Nu-Link is installed.

Executable: | openocd.exe

Remaote Development
RPM
~ Run/Debug

Console
External Tools
Launching
OpenOCD MNu-Link
Peripherals views
Perspectives
String Substitution
View Management
View Performance v

7 ) Restore Defaults Apply
@ AT @ Apply and Close Cancel

Figure 3-4 Preferences for OpenOCD Nu-Link
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3.2 Running Eclipse

To run NuEclipse, double-click the eclipse.exe. Note that the .exe file and the related folders, such as
the OpenOCD folder, should stay in the same directory; otherwise, the application will not work properly.

Mame B Date modified Type Size
configuration 2020/10/22 T 05:41 File folder
dropins 2020710722 T 05:41 File folder
features 2020/10/22 T 05:41 File folder
OpenOCD 2020/10/22 T 05:41 File folder
p2 2020/11/30 T 03:48 File folder
Packages 2020/10/22 T 05:41 File folder
plugins 2020/11/17 T+ 04:26 File folder
readme 2020/10/22 T 05:46 File folder
D eclipseproduct 2020/9/2 7 10:06 ECLIPSEPRODUCT... 1KE
1= artifacts.xml 2020710722 T 05:23 AML Document 170 KB
I% eclipse.exe 2020/9/10 £ 11:05 Application 417 KB
:.E eclipse.ini 2020/10/20 £ 10:51 Configuration sett... 1 KB
[ eclipsec.exe 2020/9/10 £ 11:05 Application 129 KE
2 notice.html 2020/9/7 7 09:35 HTML Docurment 10 KB

Figure 3-5 Eclipse.exe and Related Folders
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4 DEVELOPMENT TUTORIAL

41 Select Workspace

When Eclipse launches, we have to select a workspace which groups a set of related projects together
that usually make up an application. In addition, some configuration settings for Eclipse and projects are
stored here, too. For different computers, the configuration settings may change. We should create our
own workspace rather than copying another user’s workspace. Only one workspace can be active at
one time. The current workspace for Eclipse can be switched by clicking File->Switch Workspace.

= Eclipse IDE Launcher >

Select a directory as workspace

Eclipse IDE uses the workspace directory to store its preferences and development artifacts,

Workspace: ';'| ChUsers\ 000 eclipse-workspace w Browse...

[] Use this as the default and do not ask again

» Recent Workspaces

Figure 4-1 Selecting a Workspace
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4.2 New Project Wizard

As a beginner, the fastest way to create a C/C++ project is using the New Project Wizard. For instance,
to create a C project, click File > New > C Project. The New Project Wizard appears. Here we choose

Hello World Nuvoton Cortex-M C Project for Project type. Input the project name and click the Next
> putton to continue.

= CProject O *

C Project &

Create C project of selected type |

Project name: | FirstExample|

Uze default location
Lacation: | CG\Usersh \eclipse-workspacel\FirstExample Browse...

Choose file systern: |default

Project type: Toolchains
GMU Autotools Cross ARM GCC
Executable

& Empty Project

& Hello World ANSI C Project

& Hello World ARM C Project

& Hello World Nuvoton Cortex-M C Project
Shared Library

Static Library

Makefile project

< >

Show project types and toolchains only if they are supported on the platform

® < Back Mext > Finish Cancel

Figure 4-2 New Project Wizard
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Based on the actual target chip, we select the corresponding chip series. For some chip series, e.g.,
M2351 NonSecure, we need to input the additional library path. If not, the build process may fail. In
addition, input the real values to Flash and RAM size. If not, the default values will be used. When all
the settings are done, click the Next > buttons until clicking the Finish button.

= CProject O *

Target settings —
Select the target chip series and define flash and RAM sizes, |

Chip Series: M4E0 E o

[F1ash size (kB):

IRA.M size (kB):

Use systern calls: POSLX (system calls implernented by application code) ~
Check sorme warnings  [_|

Check most warnings |

Enable -Werror ]

Use -Og on debug

Uze newlib nano

Use link optimizations [

@ < Back Next » Einish Cancel

Figure 4-3 Target Processor Settings
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4.3 Import Existing Projects

When BSP projects are available, we can import them into the workspace using the following steps:
1. From the main menu bar, select File > Import. The Import wizard shows up.
2. Select General > Existing Project into Workspace and click Next.

3. Choose either Select root directory or Select archive file and click the
associated Browse to locate the directory or file containing the projects. In the Nuvoton BSP, the
Eclipse projects are stored in the GCC folder.

4. Under Projects select the project or projects which you would like to import and click Finish.

= Import O >
Import Projects —
Select a directory to search for existing Eclipse projects. / Af

(®) Select root directory: | C\MyCode'\bsp\M480-master-internal\bsp\SampleCode\Ten v| E Browse... i

() Select archive file: Browse...
Projects:
Template (C:\MyCode\bsp\M480—master—intemaI\bsp\SampleCodeITemplate\GCC) Select All
Deselect All
Refresh
< >
Options

[[]Search for nested projects

] Copy projects into workspace

[[] Close newly imported projects upon completion
[]Hide projects that already exist in the workspace

Working sets
] Add project to working sets Mew...
Select...
@ < Back Next > Eridr Cancel

Figure 4-4 Importing Projects
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4.4 Build Settings

After projects have been created, we still have a chance to alter the build settings by clicking Project >
Properties. The Properties wizard shows up. Then go to C/C++ Build > Settings. From there, we can
alter the build settings according to the actual target chip. Then click the Apply button to take effect.
After applying build settings, we should be able to build projects successfully.

S Properties for FirstExample O *
[type filter text | | settings Gv v 8
Resource
Builders
~ C/C++ Build Configuration: | Debug [ Active ] | | Manage Configurations...

Build Yariables
Environment

Lagging 85 Tool Settings %5 Toolchains [ Devices [J Container Settings # Build Steps Build A * | *
Settings
Tool Chain Editor (2 Target Processor ARM family cortex-mé v
Tools Paths (% Optimization ) :
C/Ce+ General @ Warnings Architecture Toolchain default ~
Linux Tools Path @ Debugging Instruction set Thumb (-mthumb) ~
; ~ 3 Cross ARM GNU Assembler
Proj.ect Netures ® = ] Thumb interwork (-mthumb-interwork)
Project References (#2 Preprocessor
Run/Debug Settings (2 Includes Endianness Toolchain default v
5 B2 Warni
Task Repository %; amings Float ABI FP instructions (hard) v
Task Tags (2 Miscellaneous
Validation ~ 53 Cross ARM GNU C Compiler FPU Type fpvd-sp-d16 -
WikiText (2 Preprocessor ] :
@ Includes Unaligned access | Toolchain default ~
(% Optimization Abrchid family  [Genenie (-mepu=generic)
#5 Warnings
( Miscellaneous Feature crc Toolchain default

~ 3 Cross ARM GNU C Linker
(% General
@ Libraries Feature fp Toelchain default

Feature crepto Toolchain default

@ Miscellaneous
~ 33 Cross ARM GMU Create Flash Image
@ General Code rmodel Small (-mecmodel=small)
~ 33 Cross ARM GMNU Print Size
@ General

Feature sirmd Enabled (+simd)

Strict align (-mstrict-align)

Other target flags

Restore Defaults Apply

@ Apply and Close Cancel

Figure 4-5 Build Settings
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4.5

Debug Configuration

NuEclipse

Before launching an application into the debug mode, we have to prepare a debug configuration, which
contains all the necessary information about the debug mode. Click Run > Debug Configuration... to
open the debug configuration dialog. Double click on the GDB Nuvoton Nu-Link Debugging group.
The Nuvoton Nu-Link debug configuration appears on the right-hand side. In the Main tab, the name of
Project should coincide with the project name. The C/C++ Application should point to the elf application
generated by the build process. If the project name or C/C++ Application is incorrect, please select the
expected project first in the project view, build the project to generate the executable, and expand the
tree to make sure the existence of the generated executable. Then repeat the former operations again.

= Debug Cenfigurations

Create,

ge, and run g

I HFeRX|B Y-

|t}fp& filter text |

[€] C/C++ Application
[€] C/C++ Attach to Application
[€] C/C++ Container Launcher
[©] C/C++ Postmortem Debugger
[©] C/C++ Remote Application
Cif C/C++ Unit

GDB Hardware Debugging

v|[c] GDB Nuvoton Nu-Link Debugging
FirstExample Debug

& Launch Group

L4 >
Filter matched 10 of 11 items

@

Name: | FirstExarmple Debug

E Main

Project:

3& Debugger | (&= Startup E/ Source | ] Common

|FirstExampIe

Browse...

C/C++ Application:

| Debug'FirstExample.elf]

Build (if required) before launching
Build Configuration: |Select Automatically

(C) Enable auto build
(®) Use workspace settings

Variables... Search Project... Browse...

() Disable auto build
Configure Workspace Settings...

Revert Apply

Apr. 25, 2022

Figure 4-6 Debug Configuration
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451 Debugger Tab

The Debugger tab is used to provide the OpenOCD and GDB Client setup. OpenOCD requires correct
configuration files to know how to work with adapters and target chips. The configuration files are
specified in the Config options field. Nuvoton’s adapter is Nu-Link, which uses the interface
configuration file named nulink.cfg. In addition, Nuvoton has three different ARM families, such as MO,
M4, and M23. The corresponding target configuration files are numicroMO0.cfg, numicroM4.cfg, and
numicroM23.cfg. For M23 2" development, the target configuration file would be
numicroM23_NS.cfg. For MA35D1 development, see Section 4.10.

S Debug Configurations

Create, ge, and run configurati
0O eE X | B Y- Name: |Fir;tExampIe Debug |
|type filter text ‘ Main | %5 Debugger [ Startup} e Source] iS] Commorﬂ
C/C++ Application OpenOCD Setup ~
JC++ Attach to Application Start OpenOCD locally
C/C++ Container Launcher - " X
C/C++ Postmortem Debugger Executable: ‘S{openocd_nu||r1k_path}f${openocd_nullnk_executable} Browse... | | Variables...
C/C++ Remote Application GDEB port: EEEE]
Cii C/C++ Unit o i
GDB Hardware Debugging elnet port
w [£] GDB Nuvoton Nu-Link Debugging Config options:

-f ./scripts/interface/nulink.cfg -f ./scripts/target/numicroMé.cfg
[T ] FirstBxample Debug

& Launch Group

Allocate console for OpenOCD Allocate console for the telnet connection

GDE Client Setup

Executable: |S{cross,preflx}gdbS{cro;s,sufflx}

Client port: 3333

Other options: |

Browse... | | Vanables...

Commands: set mem inaccessible-by-default off

Remote Target
Host name or IP address:  |ocalhost

Port number: 3333

[JForce thread list update on suspend

Restore defaults
v

< >
X Revert Apply
Filter matched 10 of 11 items

@

Figure 4-7 Configuring the Debugger Tab
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452 Startup Tab

NuEclipse

As the first step, we should choose the right Chip Series in the Startup tab. When done, the
corresponding target configuration file will be automatically written in the Config options field of the
Debugger tab. To load executable to flash, we need to select the Load executable to flash checkbox.
To load executable to RAM, we need to select the Load executable to SRAM checkbox. When all the
settings are done, click the Apply button to take effect. To launch the application into the debug mode,

click the Debug button.

‘= Debug Configurations

Create, , and run confi

DFeEBX BT~

Name: | FirstExample Debug

| type filter text

Main ﬁ;ﬁ Debugger (b Startup

[E] C/C++ Application
[E] C/C++ Attach to Application
[£] C/C++ Container Launcher
[£] C/C++ Postmortem Debugger
[E] C/C++ Remote Application
Cif C/C++ Unit
[£] GDB Hardware Debugging
~ [£] GDB Nuvoton Nu-Link Debugging
[] FirstExample Debug
& Launch Group

E/ Source} i) Commorﬂ

Initialization Commands

[ Initial Reset Type:

[] Enable ARM semihosting
Erase chip

IChip Series: | MuMicro M4~ I

Owirite Config0: Ox | FFFFFFFF Configl: Ox | FFFFFFFF Config2: Ox | FFFFSASA

Load Symbols and Executable
Load symbols
(®) Use project binary:  FirstExample.elf

() Use file:

Config3: Ox | FFFFFFFF

Workspace... File System...
Symbols offset (hex):
Load executable to flash
(®) Use project binary:  FirstExarnple.hex
(O Use file: Workspace... File System...
Executable offset (hex): I:I
[ Load executable to SRAM
Use project binary:  FirstExample.hex
Use file: Workspace... File Systerm...
Executable offset (hex):
Run/Restart Commands
Pre-run/Restart reset Type: (always executed at Restart)
[ Set program counter at (hex):
Set breakpoint at:
Continue
Restore defaults
< 3
Revert Apply
Filter matched 10 of 11 iterns
®
Figure 4-8 Configuring the Startup Tab
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4.6 Debug Views

Eclipse provides many debug views. Each of them contains specific information for debugging.

46.1 Registers View

When entering the debug mode, we can open the Registers view in the bottom of Debug perspective.
The Registers view lists information about the registers in a selected stack frame.

& Console 11} Registers 52 [2l] Problems (3 Executables &} Debugger Console  [J Memary & = | Fied § = O
Mame Value Description &)
w M4 General Registers General Purpose and FPU Register Group

1k 0

iR 0

fhl 12 536871108

1 3 537

1t rd 0

i rs 0

1 0

i 7 0

1L 8 0

i @ 0

fiot 10 536936448

£ 1 0

i 12 0

1 sp 02001 Ff3

i e 643

i pe (x32e <main+2>

1t xPSR 1627389952 v

Figure 4-9 Registers View
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4.6.2 Memory View

The Memory view of the Debug perspective is used to monitor and modify the process memory. The
process memory is presented as a list of so called memory monitors. Each monitor represents a
section of memory specified by its location called base address. To open it, click the Memory tab on
the lower side of Debug perspective.

B Console 11} Registers [*] Problems (3 Executables [} Debugger Console [J Memaory 52 = 0
101 1018 |_| i | El ER (Ebl EI] - E

Monitors gs 3¢ g (020000000 : 0x20000000 <Hex> 37 g New Renderings..]
@ (20000000 Address 0-3 4-7 §-B C-F 2

20000000 001BEF00  O001BB700  001BE700
20000010 00800000 00000000 10270000 00000000
20000020 00000000 00000000  OOLBB700 30000020
20000030 00000000  4C1BO000  6CIBO0O0  2C1BOOOO
20000040 00000000 00000000  000000CO 00000000
20000050 00000000 00000000 00000OCO 00000000
20000060 00000000 00000000 00000000 00000000
20000070 00000000  (0DOCOO0  00000OCO 00000000
20000080 00000000 00000000  00000OCO 00000000
20000030 19020000  F5010000 00000000 00000000
200000A0 00000000 00000000 000000CO 00000000
20000080 00000000 00000000 00000000 00000000

200000C0 00000000 2100D94A 10601046 C06920F0
20000000 01000061 00207047 014600BF D3430069
200000EQ 10F0010F FAD1D148 006E40F0 4000CF4A
200000F0 10602220 DO6021F0 03005060 B1F5001F
20000100 01D1CB48 90600120 8441061 BFF3608F

20000110 00BFCH48 006910F0 010FFAD1 C3480068

A PR A an nnsnan oo srnnnca s

Figure 4-10 Memory View
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4.6.3 Disassembly View

The Disassembly view shows the loaded program as assembler instructions mixed with source code for
comparison. We can do the following tasks in the Disassembly view:

1. Setting breakpoints at the start of any assembler instruction.

2. Enabling and disabling breakpoints.

3. Stepping through the disassembly instructions of the program.
4

Jumping to specific instructions in the program.

To open it, we need to click the Instruction Stepping Mode button on the upper toolbar, as follows:

w|nEeR e[ BE S

Figure 4-11 Clicking the Instruction Stepping Mode Button

Then the Disassembly view will appear on the right-hand side.

[§) mainc 52 = O  (x-Variables 9g Breakpoints & Expressions @) Modules I3 Disassembly i3 &, Peripherals =0
2 * @file main.c ~ ’—V| & SRl = = 8
3« Guereion vi.ee . Enter location here | & BBIB| et 8
4 @brief A project template for M488 MCU. 65 SYS_Init(); -~
5 » BBOBO32e: bl @x2aB <SYS_Init>
6 f@copyright (C) 2016 Nuvoton Technology Corp. All rights reserved. 67 UART_Open(UARTS, 115268);
> Sy () s £ / 80000332:  mov.w  rl, #115200 ; oxlc200
5 #include <stdic.h> 00800336:  ldr re, [pc, #12] ; (6x344 <main+24>)

9 #include "NuMicro.h” 06600338: bl @x7e@ <UART_Open>

18 59 printf("Hello World\n");

11 #define PLL CLOCK 192000000 0080033c:  ldr re, [pc, #8] 5 (Bx348 <main+28>)

12 - 6000033e: bl oxbfe <puts>
139 void 5YS_Init(void)] 80000342:  b.n 0x342 <main+22>
53 B0BE344: movs  r@, r@

548 / ©6000346:  ands 7, ré
55 This is a template project for M48@ series MCU. Users could based on this project t 00000348  subs re, re, ri
56 own application without worry about the IAR/Keil project settings. Beeso3da: movs rd, ré

CLK_SetModuleClock:
This template application uses external crystal as HCLK source and configures UART® 000e3ac:  push  {r4, r5, ré}
"Hello World”, users may need to do extra system configuration based on their syster 567 1f (MODULE_CLKDIV Msk(u32Moduleldx) != MODULE_Notisk)
’ 8000034e:  ubfx  r4, re, #10, #8
BBBRR352: cbz r4, @x386 <CLK_SetModuleClock+58>
int main() 518 if ((SYS->CSERVER & SYS_CSERVER_VERSION Msk) == @x1) // M238LD
80000354:  mov.w r3, #1873741824 ; 0x40000000
#PABO358 : ldr.w  r3, [r3, #588] ; exifa
SYs_Init(); BBBBB3SC:  uxtb r3, r3
/* Init UART to 115288-8n1 for print message */ 00000352 cmp r3, #1
UART_Open(UART®, 115200); 00A0O360:  beq.n  @x3ae <CLK_SetModuleClock+98>
/* Cannect UART to PC, and open a terminal tool to receive following message */ 536 1 (MODULE_CLKDIV(u32Moduleldx) == 2U)
printf("Hello Horld\n"); 80000362:  ubfx  r3, re, #18, #2
BBBOB366: cmp r3, #2
/* Got no where to go, just loop forever */ BBBBO368:  beq.n  @x3ec <CLK_SetModuleClock+16@>
while(1); 540 else if (MODULE_CLKDIV(u32ModuleIdx) == 3U)
BBBOD36a: cmp r3, #3
BBBBO36C beg.n @x3f@ <CLK_SetModuleClock+164>
546 u32div = (uint32 t)&CLK->CLKDIVE + ((MODULE CLKDIV(u32Mo
(C) COPYRIGHT 2016 Nuyoton Technology Corp. **/ 0000036e:  add.w r3, r3, #268435456 ; 9x18800000
© & fere v ©6000372:  adds 3, #136 ; exas v
> < >

Figure 4-12 Disassembly View
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46.4 Peripheral Registers View

To display the Peripheral Registers view, we need to utilize Packs mechanism. Packs can help the user
download special function register (SFR) files from the Keil repository. Firstly, we open the Packs
perspective by choosing it in the Open Perspective dialog.

= Open Perspective O *

FE C/C++ (default)
45 Debug

[J Docker Tooling
#% GDB Trace

[ Git

3 LTTng Kernel

I 05 Tracing Overview

) Planning

[{5 Resource

£ Team Synchronizing
Tracing

X XML

Open Cancel

Figure 4-13 Opening the Packs Perspective
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For the first time we see the Packs perspective, its content is provided by the NuEclipse installer. If the
default content is missing, please switch to a new workspace and try again. To get the latest version,
click the Update the packages definitions from all repositories button at the upper-right corner. After
clicking, Eclipse begins downloading all the SFR files from an online repository.

‘S eclipse-workspacel - FirstExample/User/main.c - Eclipse IDE - *
File Edit Source Refactor MNavigate Search Project Run Window Help
45 Debug | | [E€] FirstExample Debug v i ‘ FHEEE AR T RN =0
R A Rl = QE| @
HBo = Be ik = 0O %Packs 13 =R=] |§='E| o
BB ‘ '* g Narne Description 1)
v [= Nuvoton ~ % MNuvoton o
M 15D Family ~ [ NuMicro_DFP (installed) ~ Muveton ARM Cortex-M NuMicro Family Device Support ]
B NPCX Family 98 1310 (installed) 1. Add M253 device, update system startup file Gz
B MNuMicro MO Family 98 139 (20MB) Add MOAZ1, MO30G, MOT1, M471, NIM1244, NMI830, M251, M2354 device =
B MNuMicro M23 Family ©8 133 (18MB) 1. Add M030 device
B NuMicro M4 Family @8 137 (18MB) 1. Add M2354 device
B MNuVoice Family 98 136 (18MB) Add M480 128K series, NUCD297AN, NUCI26NEAAE, NUCI265E4AE, NUCI265G4A...
98 135 (16MB) Add MR63, M032, NUC1311, TF5103, NM18107Y, NM18202Y devices, update M45...
55. 134 (n/a) Add M261 series, M480, M031 device, update NM1000 series device
98 133 (14mB) Update M2351 Flash algorithm, M251/M252 series device and add M251 svd files
@8 132(n/fa) Add system and startup files
@8 131 (5MB) 1. Add M480 series part no.
S8 130(13mB) 1. Add M23 and M4 family
59. 1.2.2(nfa) M2351 secure and non-secure region defalt value
&8 121 (26MB) Improved PDSC file, adding include paths for device peripherals and new date fea...
59. 1.2.0 {26MB) Add M2351 and NUCZ2201 series device and svd file and update NUCL00, NUC200,...
090 1.1.0{25MB) Add M0564, NUC121, NUC125, NUC126, Mini57 and M480 series example code
0._-0 1.08 {17MB) Rename Generic series
%® 108 (17MB) Add Nanol03, NM1120, NM1330, NM1820 series svd file and update M051, M0385...
® 107 (16MB) Add NM1200 series example code and update svd file
% 106 (16MB) Add Nano103, NM1120, NM1320, NM1330, NM1820 chip, update M0519, NUC230...
% 105 (16MB) Add Mini55 chip, update Mini58, NUC100, NUC122, NUC123, Nanol00AN, Manol...
°.-,' 1.04 (15MB) Add NUC122, MO58S, Mini58, M0519 series example code
% 103 (14MB) Add M451, NUC100, NUC200, NUC123, NUCD29, MOS518, NUC131, NANC100BN, N...
%® 1.0.2 (9MB) Add ISD9100, 1502300, N571, N572 svd file and M4LED chip series
95' 1.01 (9MB) Add (M051, Mini51, Manol12, NUC240, NUCAT2) example code and new chip series
99' 1.00 (3MB) First Release version of NuMicro Device Family Pack.
3 NuMicra_M051_BSP MNuvoton ARM Cortex-M NuMicro Family MO51 BSP Support
3 NuMicro_M2351_BSP MNuveton ARM Cortex-M NuMicro Family M2351 BSP Support
3 NuVoice ISD_DFP MNuveton ARM Cortex-M NuVoice, ISD and NPCx Family Device Support

Figure 4-14 How to Download Packages
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The locations of repositories are specified in the Window > Preferences > C/C++ > Packages >
Repositories. The default is from Keil's CMSIS Pack.

= Preferences ] *

type filter text Repositories Nl .
Build ~
CMake

Code Analysis Type MName URL Add...

Code Style ) CMSIS Pack Keil https://ww keil.com/pack/index.pids |
Core Build Toolchain

Debug

Docker Container
Editor

File Types

W

Add links to the sites where packages are published.

W

W

Edit...

W

Delete

W

Indexer

Language Mappings
Meson

New C/C++ Project ¥
v Packages

W

Repositories
Profiling
Property Pages Settin
Qt
Task Tags
Template Default Val
Changelog

W

» Docker

» Help v
£ >

® @l Ié:l Cancel

Restore Defaults Apply

Figure 4-15 Locations of Repositories
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When the download is completed, we can find the Nuvoton SFR files and install them on Eclipse if

needed.
e eclipse-workspacel - FirstExample/User/main.c - Eclipse IDE B —
File Edit Source Refactor Mavigate Search Project Run  Window Help
|‘{§: Debug v | | [E] FirstExample Debug v | - | &)
0~ F - G- |
Bo = [@e ik = O %Packs
BE '* H Marne Description
v (= Nuvoton ~ [ MNuvoton
B 1SD Family ~ £} NuMicro_DFP (installed) ~ Nuvoton ARM Cortex-M NuMicro Family Device Support
B NPCX Family 9% 1310 (installed) 1. Add M253 device, update system startup file
‘W NuMicro MO Family ©® 139 (20MB) 1 . MO30G, MOT1, M4T1, NM1244, NM1830, M251, M2354 device
" nstall :
;l; MNuMicro M23 Family 9._-0 1.3.3 (18MB) —Eﬂ device
W NuMicro M4 Family &% 137 (18MB) 1. Add M2354 device
B NuVoice Family ©® 136 (18MB) Add M480 128K series, NUCO20ZAN, NUC126ME4AE, NUC1265E4AE, NUC1265G4A. .
® 135 (16MB) Add MRE3, M032, NUC1311, TF5103, NM1B107Y, NM18202Y devices, update M45..,
99. 134 (nfa) Add M261 series, M480, M031 device, update NM1000 series device
® 133 (14MB) Update M2351 Flash algorithm, M251/M252 series device and add M251 svd files
©® 13.2(nfa) Add system and startup files
°g. 131 (BMB) 1. Add M480 series part no.
%® 130 (13MB) 1. Add M23 and M4 family
9.-,. 1.2.2 (n/a) M2351 secure and non-secure region defalt value
&% 121 (26MB) Improved PDSC file, adding include paths for device peripherals and new date fea...
©® 1.2.0 (26MB) Add M2351 and NUC2201 series device and svd file and update NUC100, NUC200,...
9.-,. 1.1.0 (25MB) Add MO564, NUCL21, NUCL125, MUCL26, MiniST and M480 series example code
90. 1.09 17MB) Rename Generic series
%® 108 (17MB) Add Nanel03, NM1120, NM1330, NM1820 series svd file and update M051, M058S...
% 107 (16MB) Add NM1200 series example code and update svd file
&% 106 (16MB) Add Nanol03, NM1120, NM1320, NM1330, NM1820 chip, update M0519, NUC230...
%® 105 (16MB) Add Mini55 chip, update Mini58, NUC100, NUC122, NUC123, Nanc100AN, Manol...
99. 1.04 (15MB) Add NUC122, MO585, Mini58, M0519 series example code
&8 103 (14MB) Add M451, NUC100, NUC200, NUC123, NUC029, MO518, NUC131, NANO100BN, N...
%® 102 (@OMB) Add 1SD9100, 1509300, M571, N572 svd file and MALED chip series
99. 1.01 @9MB) Add (M051, Mini51, Nanoll2, NUC240, NUC472) example code and new chip series
S 1.00(3MB) First Release version of NuMicro Device Family Pack.
£ NuMicro_M051_BSP Nuvoton ARM Cortex-M NuMicre Family M051 BSP Support
£ NuMicro_M2351_BSP MNuvoton ARM Certex-M NuMicre Family M2351 BSP Suppert
£ NuVoice ISD_DFP Nuvoton ARM Cortex-M NuVoice, ISD and MPCx Family Device Support

Figure 4-16 Installing SFR Files
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To use the specific SFR file, open the project’s properties dialog and go to the C/C++ Build > Settings.
From there, we should choose the specific device matching the real one. In this case, it is M487JIDAE.
Click the Apply button to take effect.

= Properties for FirstExample O x
|typefi|ter text Settings - > g
Resource
Builders
v C/C++ Build Configuration: |Debug [ Active] ~ | | Manage Configurations...
Build Variables
Environment
Logging & ToolSettings 5 Toolchains M Devices [J Container Settings & Build Steps Build Artifs * | ¥
Settings
Tool Chain Editor Device selection (Mot yet used during build!)
Tools Paths MName Details G
C/Ce+ General M485SIDAE Device (160 kB RAM, 512 kB ROM)
Linux Tools Path M485KIDAE Device (160 kB RAM, 512 kB ROM)
Project Natures M48TSGAAE Device (36 kB RAM, 256 kB ROM)
Project References M487SIDAE Device (160 kB RAM, 512 kB ROM)
Run/Debug Settings M487KIDAE Device (160 kB RAM, 512 kB ROM)
Task Repository M4STJIDAE Device (160 kB RAM, 512 kB ROM)
Task Tags MAETKMCAN Device (160 kB RAM, 512 kB ROM)
Validation NUC505 Subfamily (Cortex-M4, 100 MHz)
WikiText v
£ >
Device core: Cortex-M4
Memory map (Warning: Not yet used to generate the linker scripts!)
MASTIIDAE
Section Start Size Startup
RAML 020000000 0x28000 0
IROM1 000000000 080000 1
Edit...
Restore Defaults Apply
® Apply and Close Cancel

Figure 4-17 Device Selection
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As a result, we can monitor the peripheral registers when debugging.

—] eclipse-workspacel - FirstExample/User/main.c - Eclipse IDE — x
Eile Edit Source Refactor Navigate Search Project Run  Window Help
|3§.t Debug V||r£=| FirstExample Debug v ‘ mifhd | 2w ‘ 11 d i b ) .ﬁl i 5 .‘ &%
Hr O TR @D S A B oD |
- [€] main.c &2 = B =Van.. 9% Bre.. &f Bxp.. B Mod.. ]
18/ ~ g
T2 - e main. c =
B 3 * @version V1.6 Peripheral Address Description &
4 * @brief A project template for M4s@ MCU. [, Ecar1 0x40085000 ECAP Register Map
E - . e (O 2016 echnal T | 0%, EMAC 0:4000B000  EMAC Register Map
5 = yr v Cor r s reser
E | Reomyen ) Muvaton Technology ferp. ights reserved. % EPWMO 040058000  EPWM Register Map
5 minclude <stdio.hs %, EPWML 0:40050000  EPWM Register Map
9 #include "NuMicro.h”™ 1% FMC 0x4000C000 FMC Register Map
16 . [~ GPIO| 0x40004000 GPIO Register Map
E #define PLL_CLOCK 192000600 CXHSOTG 0x4004F000  HSOTG Register Map
35 void Y5 Init(void) [, HSUSED 040013000 USBD Register Map
. [, HSUSBH 040014000 USBH Register Map
5 %, 12¢o 0x40080000  12C Register Map
6 Init System Clock O ?L jrim | 0x40081000 12C Register Map
; g Unlock ected . , 0% a2 0x40082000 12C Register Map
/* Unlock protected registers */
9 5¥S_UnlockReg(); O %_ 125 0x40048000 125 Register Map
- %, Nnv 040000300 NMI Register Map
1 /* Set XTL_OUT(PF.2) and XT1_IN(PF.3) to input mode */ 0%, NvIC 0xEDDOEL00 NVIC Register Map
2 PF->MODE &= ~(GPIO_MODE_MODEZ_Msk | GPIO_MODE_MODE3 Msk); %, opa 0x40046000 OPA Register Map
i o Enable Ext 1 XTAL (424 Bz) */ DE‘_ 0TG 0x4004D000 OTG Register Map
/* Enable Externa 24 MHz) */
s CLK_EnableXtalRC(CLK_PWRCTL_HXTEN_Msk); O, poMa 0x40008000 PDMA Register Map
6 O%, Qi 0x400B0000 QEI Register Map
7 /* Waiting for 12MHz clock ready */ %, Qm 0x400B1000 QEI Register Map
8 CLK_wWaitClockReady(CLK_STATUS_HXTSTB_Msk); %, QsPD 0x40060000 QSPI Register Map
° %, qsPi 040069000 QSPI Register Map
2 /* set core clock as PLL_CLOCK from PLL */ o .
1 CLK_setcoreClock(PLL_CLOCK); %, RTC 0x40041000 RTC Re.glster Map
3 /% Set PCLKG/PCLEL to HCLK/D */ %, s 0x40090000  SC Register Map
3 CLK->PCLKDIV = (CLK_PCLKDIV_APB@DIV_DIV2 | CLK_PCLKDIV_APB1DIV_DIV. O% sa 0340091000 SC Register Map
4 0%, s 040092000 SC Register Map
E é ;:25'3&; :nglcéiCka;;A kT HODULE )+ 0%, scs OxED00ED00  SVST_SCR Register Map
7 _EnabletoduleClock( - b %, SDHO 0x4000D000  SDH Register Map
8 /* select UART clock source from HXT =/ 0%, SoHL 0x4000E000  SDH Register Map
9 CLK_SetModuleClock (UART@ MODULE, CLK_CLKSEL1 UART@SEL_HXT, CLK_CLK %, sPio 0x40061000 SP1 Register Map
8 O%, sei 040062000 SPI Register Map
i ” ﬁPdate Sﬁte'"SCC;e ElDC'él’-’kU fatel) to caeulate Systencorect 0%, sPi2 0x40063000  SPI Register Map
/* User can use SystemCoreClockUpdate o calculate SystemCoreClo
3 SystemCoreClockUpdate(); O %_ SPIM 0x40007000 SPIM Register Map
%, svs 040000000 S¥S Register Map
5 [O%, T™MROL 0x40050000 TIMER Register Map
6 1%, TMR23 0x40051000 TIMER Register Map
; é\tsseépgpaFQ:léi7ﬂE;\cf§i;:Ep;2;H‘Fgﬂ-lg;‘;g.lp—eNRiD| a:‘iSTégE“;:FPH PB13MFP g %' TRNG Ox3008000 TRNG Register Map
. = s
9 SYS->GPE_MFPH |= (SYS_GPE_MFPH_PB12MFP_UART@_RXD | SYS_GPB_MFPH_PB O, UARTO 0x40070000 UART Register Map
%) /* Lock protected registers */ [, UARTL 0x40071000 UART Register Map
1 SYS_LockReg(); 1%, UART2 0x40072000  UART Register Map .
2} [ Py - . cem . e
53 < >
54 /%
55 * This is a template project for M48@ series MCU. Users could based o
56 = own application without worry about the TAR/Keil project settings.
57 -
58 * This template application uses external crystal as HCLK source and
59 * "Hello World", users may need to do extra system configuration base
0 =/
a1 v
< >
Bl Console 13} Registers [#] Problems () Executables [ Debugger Consale [J Memory 52 R .'L" ot EE <§>‘ v & =0
Menitors 2 3 % (2, GPIO:0x40004000 3% &b New Renderings...|
@ 020000000 Register Address Value )
& GPIO > 8 PA DINOFF 0x40004004 000000000
~ i PA_DOUT 0x40004008 0:x0000FFFF
S DOUTO 10] 0:d: 1
2 DoUTL 1] 0::1
5 DOUTIO 10] 01
& DOUT11 [11] 0:d:1
S DOUTL2 112] 0:d: 1
2 DoUTI3 113] 0::1
& DOUT14 [14] Oud:1
B DOUT1S [15] Oxl: 1
= DOUTZ [2] 0xd: 1
& DOUT3 [3] 01
& DOUT4 [4] Oud:1
5 DOUTS [5] Oxl: 1
= DOUTE [6] 0xd: 1
5 DOUTT 7 01
& DOUT8 [8] Oud:1
2.DOUTY 19] 0l

Figure 4-18 Peripheral Registers View
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4.7 Watchpoints
To add watchpoints on Eclipse, we need to do the following steps:
1. Selecting a globe variable, i.e. g_seconds, in the Outline view.

2. Right-clicking on the global variable and choosing Toggle Watchpoint.

S eclipse-workspacel - FirstExample/User/main.c - Eclipse IDE - *
Eile Edit Source Refactor Mavigate Search Project Run  Window Help
|%§: Debug V|| FirstExample Debug w | Il | &) B = | [ [ A T 4 | i+ = 4}2,.. %
H- Q- Q@O F A F e D D Q ®|
E- main.c i3 = B ®=Var. 9 Brea.. @7 Bpr.. 5= Outli. 5 =¥ Disa. 3, Peri. =
18 " a s 9
¥ 2 * f@ifile main.c o stdioh CEAERY ®
By 3 * fversion V1.@@ e
4 * @brief A project template for M488 MCU. & NuMicro.h
5 * # PLLCLOCK
6 * {lcopyright (C) 2816 Nuvoten Technology Corp. ALl rights reserved. & g_seconds: unsigned irt
; #includ tdio.h @  SYS Init{void) : void Open Declaration F3
il i e ® mainQ: int Open Call Hierarchy Ctrle Al H
1@ Open Include Browser Ctrl+Alt+I
11 #define PLL_CLOCK 1926668008
12 Refactor ]
T3 unsigned int FIELTOCE = ©;
14= void SYS_Init(void) Declarations >
ig { e e ] References >
1; .:: Init System Clock Iﬁﬁ Toggle Watchpoint

Figure 4-19 Toggle Watchpoint
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3. Configuring the settings for watchpoints. To stop execution when the watch expression is read,
select the Read checkbox. To stop execution when the watch expression is written to, select

the Write checkbox.

= Properties for C/C++ Watchpoint O *
Comman Common - ~ 2
Class: C/C++ Watchpoint
Project: FirstExarnple
File: ChUsersy \eclipse-workspacel\FirstExample\Userymain.c

Expression to watch: | g_seconds
[JRange:

[JRead
Write
Enabled

Condition: | |

Ignore count: |U |

® Apply and Close Cancel

Figure 4-20 Properties for C/C++ Watchpoint

When the watchpoint is added, it appears in the Breakpoints view.

(x)= Var.. @gBre.. 31 6 Ex. = Out. BjMe.. ZDis. Z Per. = O
&

XRSBHABES
& [function: main] [type: Temporary]
47 main.c [expression: 'g_seconds']

Figure 4-21 Added Watchpoint in the Breakpoints View

Rev 1.02.019
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48 Debugin RAM

To debug in RAM, there are several steps to follow:
1. Modifying the Id script.
2. Assigning PC to the specific RAM address.

3. Assigning SP to the specific RAM address.
4. Downloading the binary file to RAM.

The Id script is responsible for telling the linker the layout of the compiled executable. For example, the
memory layout looks like:

8K
0x20001800
g
5
5K =
a
C
a
0x20000000 =
2
>

Figure 4-22 Memory Layout
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The modified Id script should meet the memory layout design.

S cclipse-workspacel - FirstExample/CMSIS/GCC/gee_arm.Id - Eclipse IDE - *®
File Edit Source Refactor MNavigate Search Project Run  Window Help
|%$Debug vHEFirstExampleDebug v ‘ g~ |®v5§'@ El ‘Q“AE.’.% Eirai- @~
H-0- Q- So I RETIH G- Qo Z|@E% %W
[ Project Explorer &2 = B  [d mainc [ ] memset() at (08 2 gec_armuid 22 = 0 5
B <§> T 8 1/* Linker script to configure memory regions. */ -
= FirstExample ;?EMRY
Be
> 3%, Binaries 4 [FLASH (rx) : ORIGIN - ©x2@@@186@, LENGTH - &K
> [t Includes 5 |RAM (rwx) : ORIGIN = @x20000088, LENGTH = 5K
v (2 CMSIS 61
v (= 6CC L . )
[6) _syscallsc 2/* Library configurations */
> Ml syscall.c 9 GROUP(1libgcc.a libc.a libm.a libnosys.a)
> 0] semihosting.h 18
> |§] startup_M480.5 11 /% Linker script te place sections and symbol values. Should be used together

12 * with other linker script that defines memory regions FLASH and RAM.
13 * It references following symbols, which must be defined in code:
14 * Reset_Handler : Entry of reset handler

> |ig) system_M480.c

15 *
~ (2 Library 16 * It defines following symbols, which code can use without definition:
> = CMSIS 17 *  _ exidx_start
5> (= Device 18 *  _ exddx_end
5 = StdDriver 12 * _ copy_table_start__
[ dke 28 * _ copy_table_end
? } 21 * _ zero_table_start__
> [ retarget.c 22 *  zero table end
> [ sysc 23 *  _ etext
5 € varte 24 * _ data_start
v (@ User 25 * _ preinit_array start
26 * _ preinit_array end
> 2 main.c 27 * _ init_array_start
> (= Debug 28 * _ init_array_end
,a preferences.ini 20 *  _ fini_array_start
3@ *  _ fini_array_end

Figure 4-23 Modifying the Id Script
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To assign PC and SP to the specific addresses, we need to input them in the debug configuration, as
follows. Based on the previous memory layout, the PC and SP addresses should be Reset_Handler and
0x20001400, respectively. In addition, set Vector Table Offset Register (OXEOOOEDO08) should be
0x20000000 and unselect the Pre-run/Restart reset Button. To download the binary to RAM, we select
the Load executable to SRAM button and unselect the Load executable to flash button. Click the
Debug button to start a debug session.

‘S Debug Configurations m} x
Create, ge, and run figurati
OFeR X | B Y - MName: |FirstExampIe Debug |
|t_~,rpe filter text | Main ﬁ& Debugger (D Startup 1 Sourcew = Commorﬂ
[©] C/C++ Application Initialization Commands
[T] C/C++ Attach to Application [ Initial Reset Type:

[€] C/C++ Container Launcher
[€] C/C++ Postmortem Debugger
[€] C/C++ Remote Application
Cif C/C++ Unit
[] GDB Hardware Debugging
~ [E£] GDB Nuvoton Mu-Link Debuggine
[t Firstexample Debug [ Erase chip
i3 Launch Group Chip Series: | NuMicro M4~

[]Enable ARM semihosting

[ write Config0: 0x | FFFFFFFF Configl: 0x  FFFFFFFF Config2: 0x | FFFFSASA Config3: Ox | FFFFFFFF

Load Symbols and Executable
Load symbols
(®) Use project binary: FirstExample.elf

(O Use file: Workspace... File System...
Symbols offset (hex):

[] Load executable to flash
Use project binary:  FirstExample.hex

Use file: Workspace... File System...

Executable offset (hex)
Load executable to SRAM
(®) Use project binary: FirstBxample.hex

(O Use file: Workspace... File System...

Executable offset (hex):

Run/Restart Commands

[]Pre-run/Restart reset Type: |init | (always executed at Restart)

set §sp=0x20001400|
set Spc=Reset_Handler
monitor mww 0xE000EDOS 020000000

[ 5et program counter at (hex):

Set breakpoint at:

Continue

Restore defaults

< >
Filter matched 10 of 11 items

@

Revert Apply

Figure 4-24 Debug Configuration Settings
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When the program stops in the main function, we open the Memory view. From there, we can verify that
the binary file is successfully downloaded into RAM. The first word denotes the SP address. The
following words denote the addresses of handlers.

= eclipse-workspacel - FirstExample/User/main.c - Eclipse IDE - ¥
File Edit Source Refactor MNavigate Search Project Run Window Help
|v§;nebug V||E|Fir;tExampleDebug v ‘ o EH=EES - e A
H-0- Q- @O S-S er0 Q g Es
5 [€ main.c 32 gec_am.ld = B x=V. 9B. & E. EE 0.. By M. T = B8
i T T - -7 Tooa 0:20002149 vl & @SB/ et 8
/* Update System Core Clock */
E Reset_Handler: A
& /* User can use SystemCoreClockUpdate() to calculate SystemCoreClock. */ IZBBBQIA-B' 1dr r1, [pc, #88] ; (Bx2888219C (RESJ
: ) ) H
SystemCoreClockUpdate(); Py Tor 2, = dats start
2000214a: Ldr r2, [pc, #84] ; (8x200021a@ <Rese
238 ldr r3, =_ data_end__
2880214c: Ldr r3 C, #84 ; (@ex28@@21a4 <Rese
/* Set GPB multi-function pins for UART® RXD and TXD */ a1 cmp r2 :_3['9 ’ 1ost
5Y5->GPB_MFPH &= ~(SYS_GPE_MFPH_PB12MFP_Msk | SYS_GPB_MFPH_PB13MFP_Msk); J6002145:  cmp la e3
5Y5->GPB_MFPH |= (SYS_GPB_MFPH_PB12MFP_UART@_RXD | SY5_GPB_MFPH_PBL3MFP_U/ - ’ Teee 1t
/* Lock protected registers */ 20002150 ittt 1t =
5Ys_LockReg(); 243 ldrlt  r@, [rl], #4
} 20082152:  ldrlt.w r@, [r1], #4
al r+ 244 strlt ré, [r2], #4
558/ P . - . 2808821561 strlt.w re, [r2], #4
56 * This is & template project for M48@ series MCU. Users could based on this | 245 blt .L_loopl
57 ¥ own application without worry about the IAR/Keil project settings. 28882153+ blt.n " @x20809214e <Resct Handler+6s
+ : - _
=8 ) o ) 306 1dr re, -0x40000100
59 * This template application uses external crystal as HCLK source and configur 2008215 : 1dr 8, [pc, #72] ; (8x200021a8 <Rese
58 * "Hello World", users may need to do extra system configuration based on the 207 ’ ldr r1, -0x59 *
6 =/ s
6L | = 20002152:  mov.w  rl, #89 ; @x59
62_ . . 388 str rl, [r@]
63= int main() 20002162:  str r1, [r@, #0]
R { — 309 1dr r1, =exi6
65 EERE ) 20002164:  mov.w  rl, #22
66 /* Init UART to 11520@-8nl for print message */ 318 strorl, [r8]
3
67 g_seconds = 1; 20062168:  str r1, [r@, #0]
68 UART_Open(UART®, 11520@); 311 ldr rl, =Bx38
69 ) ) ) 2000216a:  mov.w rl, #136 5 exas
76 /* Connect UART to PC, and open a terminal tool to receive following messg 312 str r1, [re]
. " . s
71 printf("Hello World\n"); SBea216e: str r1, [re, #0]
72 . ) . N 315 ldr r@, -Bx48000200 /= R = C1
73 ‘h_g“ no where to go, just loop forever */ 20002170:  ldr r@, [pc, #56] ; (Bx200021ac <Rese
;‘; while(1); 316 ldr r1, [re,#exa] /% R1 = oy
. } - 20002172:  ldr r1, [re, #a] w
< > < >
B Console 13 Registers [2] Problems () Exscutables [l Debugger Conscle [ Memory 53 QU <‘==='(>| g~ 8 = 0
Menitors <= 3 % [0x20001800 : 0x20001800 < Traditional> & - New Renderings...|
& 0x20001800 Exzooum 20001406 20602149|20802165 20001F60 20002165 20062155 20002185 pl. pl. opl, ~
@%2000181C 20002185 70002105 20000000 o Cplepl e
Bx20001838 20002185 20002165 20002165 20002165 20002185 20002165 20802185  u!. p!. o pl. pl. pl. plo opt.

Figure 4-25 Debugging in RAM
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4.9 Debug Executable Files Only

If the user has an executable built with debug symbols but may not have the relevant environment used
to build the executable, he still is able to debug the executable by the following steps:

1. Import an executable for debugging (referring to Figure 4-26).
2. Click Browse following Select executable, then select an executable (referring to Figure 4-27).

3. Choose GDB Nuvoton Nu-Link Debugging as a Launch Configuration (referring to Figure
4-28).

4. Locate the GDB executable in the debug configuration (referring to Figure 4-29).

5. Choose the ELF file to download in the debug configuration (referring to Figure 4-30).
6. Add source lookup path relative to source folders (referring to Figure 4-31).
7

Press on the Debug button.

= Import O >

Imports a C/C++ executable file. Will create a project and launch configuration for debugging. E - 5 |

Select an import wizard:

w = CIC++ Y

LE@ C/C++ Executable I
e CfC++ Project Settings
Existing code as Autotools project
Existing Code as Makefile Project

= Git

(== Install

= Comph

= RPM

= Run/Debug

= Tasks

= Teamn

= TextMate

[= Tracing

= |

?\ < Back Mext = Finish Cancel

Figure 4-26 Importing Executable for Debugging
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| pod

= Import Executable

Import C/C++ Executable Files

Select a file or a directory to search for C/C++ executable files.

Select binary parser: | EIf Parser w

(®) Select executable: |5 ‘eclipse-workspa ce\M48ﬂ\Debug\M| Browse...

() Search directory: Browse...

CfC++ Executable Files:

Select All

Deselect All

@ = Back Mext = Einish Cancel

Figure 4-27 Selecting Executable
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= Import Executable O ot

Choose Project

Choose an existing project or create a new one,

(®) New project name: | Debug_M480.elf

The new project will let you debug but not build the executable,

() Existing project: Search...

Create a Launch Configuration: | GDB Muvoton Mu-Link Debugging =

Mame: | Debug_M480.elf

® < Back Mext = Cancel

Figure 4-28 Choosing GDB Nuvoton Nu-Link Debugging
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= Debug Configurations

[} *
Create, ge, and run i i

CHeEX BT -
|typef\\tertaxt

[€] C/C++ Application
[T] C/C++ Attach to Application
[€] C/C++ Container Launcher

(] C/C++ Postmortem Debugger Executable: |S{openocd_nulink_path}/!{openocd_nuhnk_axecutable}
[€] C/C++ Remote Application

GDB port: 3333
Cif C/C++ Unit
[€] GDB Hardware Debugging Telnet port: 4444

~ [ ] GDB Nuveton Nu-Link Debugging Config options: | -f  /scripts/interface/nulink.cfg - ../scripts/target/numicroMd.cfg
[T Debug_M480.elf
[E] M480 Debug
R Launch Group

Name: | Debug_M480.elf (1)

Main rﬁ&- Debugger “_ [ Startupw By Source} = Commorq
Open0CD Setup
Start OpenOCD locally

Browse... | Variables...

Allocate console for OpenOCD Allocate console for the telnet connection

GDE Client Setup

Executable: | ’rogram Files (x36)\GNU Tools ARM Embedded\6 2017-g1-update\bin\ i h e Se e 0e || Browse... | Variables...
Client port: 3333
Other options: |
Commands: set mem inaccessible-by-default off
Remote Target

Host name or IP address: localhost

Port number: B33

[1Force thread list update on suspend

Restore defaults

Filter matched 11 of 13 items

@

Revert Apply

Figure 4-29 Locating the GDB Executable
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& Debug Configurations m} *
Create, ge, and run fig
CeemX| BV - MName: | Debug_M4g0.elf (1)
‘typefiltertaxt | Main ﬁi‘*‘ Debugger rb Startup . B Sourcew =] Qommoﬂ
C/C++ Application Initialization Commands

C/C++ Attach to Application

C/C++ Container Launcher

C/C++ Postmortem Debugger

C/C++ Remote Application
[T] M480 Debug

Cif &/C++ Unit

GDB Hardware Debugging

Initial Reset  Type:

[]Enable ARM semihosting

DE MNuveten Nu-Link Debugging Erase chip
[ ] Debug M480.elf Chip Series: | NuMicro M4~
[T ] M480 Debug .
£ Launch Group [Jwrite Config0: Ox | FFFFFFFF Configl: Ox  FFFFFFFF Config2: Ox | FFFFS5ASA Config3: Ox  FFFFFFFF

Load Symbals and Executable
Load symbols
(®) Use project binary: M480.elf

() Use file: Workspace... File System...
Symbols offset (hex):

Load executable to flash
(O Use project binary:  M480.hex

®) Use file: | C:hUsersy, \Desktop\M480.elf Workspace... File System...

Executable offset (hex):
[ Load executable to SRAM
Use project binary:  M480.hex

Use file: Workspace... File System...
Executable offset (hex):

Run/Restart Commands
Pre-run/Restart reset Type: - (always executed at Restart)

[ 5et program counter at (hex):

Set breakpoint at:

Continue

Restore defaults

Revert Apply

Filter matched 12 of 15 items

®

Figure 4-30 Choosing the ELF File to Download
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= Debug Configurations

Create, manage, and run configurations

U B & B %| B 7 ~ || Name: [Debug Mis0.f @)

|t}rpefilterta¢ | Main rﬁ: Debugger rb Startup rE/ Source _[] Commonw
[©] C/C++ Application Source Lookup Path:

[c] C/C++ Attach to Applicati + lzp M480 - Path Relative to Source Folders Add...
[c] C/C++ Container Launche g C\Users\ \eclipse-workspace\M480VCMSIS
[c] C/Cr+ Postmortem Debu, [ C:\Users) \eclipse-workspace\M480\Library Edit..
w [E] C/C++ Remote Applicatio (53 C:\Users\ \eclipse-workspace\ M480\User
[T] M480 Debug = Remove
Cif C¢/Ce+ Unit 5 [ Path Mapping: Found Mappings Up
[c] GDB Hardware Debugging
+ [T ] GDB Muvoton Nu-Link Det Down

[©] ACMP_WindowComap
[ ] Debug_MA480.elf Restore Default
[©] Debug_rithread.lf
[£] M2354 Debug
[£] M480 Debug
[£] NUC123 Debug

& Launch Group

[] Search for duplicate source files on the path

£ >
) . Revert Apply
Filter matched 16 of 19 items

@ Ciose

Figure 4-31 Adding Source Lookup Path
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410 Configuration of Cortex-A, Multi-core SMP and AMP system

4.10.1 Preliminary Preparation

Suggest using Nu-Link2 family as debugger, and being sure to upgrade Nu-Link2 firmware version
higher than v3.09.7380r.

The term SMP stands for symmetric mulitiprocessing, AMP is asymmetric mulitiprocessing.

Nu-Link2 had built-in CMSIS-DAP interface from v3.09.7380r, and this CMSIS-DAP interface is used to
support Single Cortex-A, Multi-Core SMP and AMP (Cortex-A + Cortex-M).

Besides, NuEclipse provides GNU toolchain for the Cortex-A family which resides in NuEclipse/Others
folder. After configuring this toolchain (see Section 3.1.3), we can build MA35D1’s projects.
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4.10.2 Configuration of debugging Single-core Cortex-A

This section describes how to configure a single Cortex-A core debug.

Take Nuvoton MA35D1 as an example, which has dual Arm Cortex-A35 cores and one Arm Cortex-M4
core. To debug it, we should choose NuMicro A35 and resume the target at the position where the
executable starts running in the Startup tab, as follows. For more details, please refer to Section 4.5. To

download other images, the command would be: monitor load_image filename address.
To load other script, the command would be: monitor script filename.

E.g. load DDR initial script or change adapter speed, as follows.

Main | %5 Debugger | B+ Startup | &~ Source| [7] Common
[] Initial Reset Type: |init

moniter script . /scripts/board/numicreMA35D1_DDR3_256MB_1066MBPS_WINBOND.cfg
moniter adapter speed 2000

[] Enable ARM semihosting
Erase chip

I Chip Series: | NuMicro A35

Write Configl: Ox  FFFFFFFF Configl: Ox | FFFFFFFF Config2: Ox | FFFFFFFF Config3: Ox | FFFFFFFF

Load Symbaols and Executable
Load symbaols

(®) Use project binary: rtthread_aarch32_smp_lite.elf
() Use file:
Symbols offset (hex): l:l
Load executable to flash
Use project binary:  rithread_aarch32_smp_lite.elf
Use file:

Load executable to memory
(®) Use project binary:  rithread_aarch32_smp_lite.elf
() Use file:

Executable offset (hex): l:l

Run/Restart Commands

Pre-run/Restart reset Type: (always executed at Restart)

moniter load_image C:\ma35d1.dtb 0x28018000
moniter load_image C:\bI31.bin (28020000
monitor resume 0x28000000

monitor reset halt]

[ 5et program counter at (hex):
[ Set breakpoint at: main
[] Continue

Figure 4-32 Configuring the Startup Tab for MA35D1
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When the images are too large, the download command may face a timeout. To avoid that, go to
Window > Preferences > C/C+ > Debug > GDB and disable the Command timeout or increase it.

= Preferences [m] x
type filter text GDB =R - 8
o ?,‘e(?ffl = General settings for GDB Debugging
Appearance Debug Configurations Defaults
Autotools GDB debugger |gdb | Browse...
v Build
Build Targets DB command file [-gdbinit || Browse
Build Variables
Consola [ stop on stsrtup at |mam ‘
Environment [] Command timeout {ms) 100000 Adhmnced ‘
Global Tools Path
Logging [ Mor-stop mode (Mote: Requires non-stop GDE)
Makefile Editor [ Use external cansole for inferior fopen a new consele window for input/output)
Settings [ Remote timeout (seconds)
Warkspace Tools
CMszke General Behavior
EDSE?nTIySIS [ Terminste GDE when last process exits
ode Style
~
Core Build Toolchai [ Use enhanced debug hover
« Debug [ show only suspended thresdsin the Debug Wiew
Breakpoint Actior Use aggressive breakpoint filtering
Disassembly [ 5how the GDB traces consoles with character limit: |500000 ‘
Floating Peint Me
GoE [ Maxirnurn number of linesto display per message in GDE traces: |S ‘
Source Lookup F Displsy run-time type of varisbles (Mote: requires GDB 7.5 ar higher)
Tracepaint Actior
Traditions| Merm Pretty Printing
Docker Container Enable pretty printers in varisblefexpression tree (Note: requires python-enabled GDE)
Editz
oror For collections, initially limit child count to |100
File Types
Indexer
Language Mapping
Mesen
Mew C/C++ Project
Packages
Profiling v
Restore Defaults Apply
< >
O I@A IQ. @ Apply and Close Cancel

Figure 4-33 How to Disable Command Timeout
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To debug single A35 core, we have to disable CPU1 setting by commenting out the following code in
the numicroMA35D1.cfg. On Windows, the location where numicroMA35D1.cfg resides could be
C:\Program Files (x86)\Nuvoton Tools\ OpenOCD\scripts\target. On GNU/Linux, it could be
/usr/local/OpenOCD/scripts/target.

cti create CHIPNAME.cti.sys -dap
cti create CHIPNAME.cti.cpul -dap
|#cti create § CHIPNAME.cti.cpul -dap
cti create 5 CHIPNAME.cti.cmd4 -dap

5_
5_

target create CHIPNAME.axi mem ap -d
target create CHIPNAME.cpul aarchéd
‘#target create $ CHIPNAME.cpul aarché4
target create 5 CHIPNAME.cm4 cortex m

5_
5_

‘#target smp 5 CHIPNAME.cpuO $ CHIPNAME.cpul
5 _CHIPNAME.cpuO aarch64 maskisr on
#5_ CHIPNAME.cpul aarch64 maskisr on

|#pr0c smp_cpul {} {
# $:: CHIPNAME.cpul aarch64 dbginit
#}

5 CHIPNAME.cpuO configure -rtos hwthread

HS_CHIPNAME.cpul configure -rtos hwthread

5 _CHIPNAME.cpu(O configure -event reset-assert {smp cpu0}

#5 CHIPNAME.cpul configure -event reset-assert {smp cpul}

5 _CHIPNAME.cmd4d configure -event examine-start {dbgmcu_enable debug}
5 _CHIPNAME.cmd4 configure -event reset-assert {reset mid}

Figure 4-34 Disable CPU1 Setting

After choosing NuMicro A35 in the Startup tab, the numicroMA35D1.cfg will be automatically updated
in the Config options field of the Debugger tab. Because of single-core debugging, the OpenOCD GDB
port and GDB client port should be the same value, e.g., 3333. When all the settings are done, click the
Apply button to take effect. To launch the application into the debug mode, click the Debug button.

S Debug Configurations o =
Create, manage, and run configurations ﬁ/\
Fo@RX BV - Narme: | 435_CPUD_Demo
tyee filber tet Main [ 35 Debugger @ Startup| B Source [7] Common
C/C++ Application OpenOCD Setup
CfC++ Attech to Application [ Start OpenOCD localky

C/C++ Container Launcher . — - — - - :
C/C++ Postmortem Debugger Executable | $lactive_care_build_dif$lop |_rulink,_pathl/op ¥ . | |Browss.. | |Varisbles..

CjC++ Remote Applicstion GDB port 3333 |

FIF £ FIRIFIRIE

CfC++ Unit
GOB Herdware Debugging Telnetport  |4444 |
v [£] GOE Nuvaton Mu-Link Debugging Config options | _scry v e dun o Jrnptsherget o501 o
[C] A35_CPUD Dema
[E] 435_CPU1_Dema
~ @ Launch Group
7 Duelazs Sl e e E e Allocate console for the telnet connection
GDE Client Setup
Executable: .‘[crossﬁrefi:dgdbi[cmss,wffi:d r— T
Clientport [3333 ]
Cther eptions: |
< d5 | set memi ble-by-default off
Remaote Target

Host neme or IP address. lox

Port number:

[ Force thread list update on suspend

Figure 4-35 Configuring the Debugger Tab for Single-core Debugging on MA35D1
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4.10.3 Configuration of debugging Dual-core Cortex-A in SMP mode

To debug SMP, e.g. dual A35 core, please refer to Section 4.10.2, but bypass the step that disabling
CPUL setting.

4.10.4 Configuration of debugging Single-core Cortex-A and Cortex-M in AMP mode

To debug AMP, e.g. one A35 core and M4 simultaneously, we build the A35 and M4 projects and create
the corresponding debug configurations (see Section 4.5). The debug configuration of A35 follows
previous section to complete settings. However, the debug configuration of M4 differs from the Debugger
Tab. Uncheck the Start OpenOCD locally checkbox. The value of GDB Client port and Remote Target
port is set to 3334.

Eeo@X| B Y~ Mame: | M4_Templste
type filter text [] Main | %F Debugger B Startup | 5 Source| (] Comman
[€] ©/C++ Application OpenOCD Setup

[E] CAC++ Container Louncher:

[E] ©/C++ Attach ta Applicotion

[E] ¢/C++ Postmorem Debugger Executable: ink_path}/openocd E
[E] ¢/C++ Remote Application GDB port
Cif ©/C++ Unit
[£] 608 Hordware Debugging Telnet pert
~ [€] GDB Muvoton Nu-Link Debugging Config options. -f _fseripte/interdacs/cmsas-dap cfg - _/seriptetargetinumieraMAISD1 cfg
[£] 435_CPUO Demo
[ A35_CPU1_Demo
[T ] Md_Template
v & Lounch Group Alseate cansale far OpenOCD Allocate cansele for the telnet connection
8§ Duelas GDB Client Setup
Executable. | $lernss prefod glb§ferass suffid Browse.. Variohles
Clientport: 3334
Other sptions
ds .salﬂEl" by-default off
Remote Target

Host name or [P address |localhast
Pert number. 3334

[JFarcethresd list update on suspend

Figure 4-36 Configuring the Debugger Tab for Multi-core Debugging on M4 core
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To launch A35 and M4 applications simultaneously, we use Launch Group by the following steps:

1. Give a name to the newly created launch group.

N o g s~ wDd

Press on the Add button.

Press on the OK button.

Press on the Apply button to take effect.

Add the expected launch configurations to the launch group.

Move the A35 launch configuration in the first sequence order.

Press on the Debug button to run the group launch.

CEoREX BTV~

Narne: [DuslAds

[typetiter tet

# Launches [ Commen|

[E] C/C++ Applicstion
[E] C/C++ Attach to Application
[E] C/C++ Container Launcher
€] C/C++ Postmortemn Debugger
[] C/C++ Remote Application
CH C/C++ Unit
[£] GDE Harchvare Debugging
+ [£] GDB Nuvoton Nu-Link Debugging
[£] A35_CPUD Derno
[E] A35_CPUT Deme
[E] Md_Templste

¥ Launch Group
& DuslAzs |-

Filker matched 13 of 23 items

Marne

Mede Action

Up

[£] GDE Nuveton Nu-Link Debugging:A35_tPUD_Demo
[£] GDB Nuvoton Mu-Link Debugging: M4 _Template

Inherit
Inherit | 5, Down

Edit

& Add Launch Configuration

Add one or more launch configurations o the launch group

o/l add

Remove

[type fiter text

[©] C/C++ Application
2] GDE Muvoton Nu-Lnk Debugging
[£] A35_CPUO_Demo
[] A35_CPU1_Demo
[£] M4_Template 3.

Launch mode: Inherit v
Post launch action: | None v

[ Adopt lsunch if already running

@

Cangel

Revert Apply

@

7. e
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4.10.5 Configuration of debugging Dual-core Cortex-A and Cortex-M in AMP mode

To debug AMP, e.g. dual A35 core and M4 simultaneously, we have to disable the CPU Symmetric Multi-
Processors (SMP) by commenting out the following code in the numicroMA35D1.cfg. On Windows, the
location where numicroMA35D1.cfg resides could be C:\Program Files (x86)\Nuvoton Tools\
OpenOCD\scripts\target. On GNU/Linux, it could be /usr/local/OpenOCD/scripts/target.

targets §_CHIPNAME.zpul

#target swp § CHIPMAME.cpul § CHIPNAME.cpul
S_CHIPNAHE.cpuD aarchéd maskisr on
$_CHIPNAHE.cpu1 aarchi4 maskisr on

Figure 4-38 How to Disable SMP

The debug configuration of A35 CPUO follows Section 4.10.2 to complete settings. The debug
configuration of A35 CPU1 and M4 follows Section 4.10.3 to complete settings, but the value of GDB
Client port and Remote Target port differs. That of A35 CPU1 and M4 is 3334 and 3335, respectively.
The Launch Group should include the launch configurations of A35 CPUO, CPU1 and M4. Make sure
that the A35 CPUO launch configuration is in the first sequence order, then press on the Debug button
to run the group launch. While entering the debug mode, we can switch different CPU core to debug by
clicking on the corresponding execution of threads in the Debug view.

15 Debug & I Frojectbxplorer (=] ¢ [ 4% | = C
v £, DuslAds [Leunch Graup]
5 epenoed cmss-dep e

= O o Varishles ¥ Breskpoints &7 Expressons B\ Modules 557 Disassembly 7

102 if (handler L-8)
BATE clock */ © o ldr @, [sp, #18]
*)@KABEEIO0, dnp32((woid *IEKAGIEDZC) | (1 << 32)); S/ Uart CLK § & e
+)EXA060220, Inp32( (void *)EKAGIE0220) & (3 < 16)}; // Lart CLK frem HAT
4JREG_LARTO_LCR, inp32((vaid *)REG_LARTA LCR) | 0xd7);
o +)REG_LKATO_BALD, 2x30 ): for 9600 WHNID *
itp32((void *]REG_WRTE_IER, 2); Enstle TX empty interrupt

070c4 <IRQINterruptssss // b.
=)0;
S

functian *
i *)SYS_GPE_WFPH, (inp32((void 4)SYS_GPE_WFPH) & ~@xff000000) | ©x11000002);

* main function */
=it main{vodd)

1
axieanenee:
CE0D0RA25R07GG 1
142

v s Thread #1 (Suspended : Breakpaing
= meing stmein <85 0:310| M4 RTP

J& erm-none-eobi-gdb

3
exe00000002600708c s str
i

» ledstate = ledState + 1

*s test A3S = test 435 + 1;
" Dalay(500);
¥
s )
< >
) Comsole i) Registers 7 5y Pragress (] Problems () Executobles A Debugger Consale (¥ Debug Sources 00 Memory @ Consale
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125 o0
11 226 [
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30 00
i s 6280064f0
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Figure 4-39 Multi-core Debugging
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4.10.6 Configuration of debugging Cortex-A Core in AARCH32 mode

The settings in chapter 4.10 are mostly for ARM v8a AARCH64 mode by default. In this section, we
describe how to debug a AARCH32 application.

For example, to debug AARCH32 program on Cortex-A35, we first enter debug mode to run AARCH64
code and leave debug mode. And then re-enter debug mode switching to AARCH32 code for debugging.
We import executable files (see Section 4.9) and create the corresponding debug configurations (see
Section 4.5). On Windows, the location where numicroMA35D1.cfg resides could be

C:\Program Files (x86)\Nuvoton Tools\OpenOCD\scripts\target. On GNU/Linux, it could be
/usr/local/OpenOCD/scripts/target. There are several steps to follow:

1. Import an executable for debugging (referring to Figure 4-26).
2. Click browse following select executable, then select an executable (referring to Figure 4-27).

3. Choose GDB Nuvoton Nu-Link Debugging as a Launch Configuration (referring to Figure
4-28).

4. Locate the GDB executable in the debug configuration (referring to Figure 4-40).

5. Choose the ELF file to download and initial setting in the debug configuration (referring to
Figure 4-41). Please based on DDR of dev-board to select the corresponding DDR initial file.

6. These files could be found in C:\Program Files (x86)\Nuvoton Tools\OpenOCD\scripts\board
folder.

7.  (monitor Script ../scripts/board/numicroMA35D1_DDR3_256MB_1066MBPS_WINBOND.cfg)
8. Press on the Debug button.

9. Set breakpoint at the last address of aarch64 program and resume to the address.

10. Press run button and then leave debug mode.

11. Uncheck the reset settings and re-enter debug mode (referring to Figure 4-42).

12. Debug AARCH32 program (referring to Figure 4-43).

The above description is for debugging AARCH32 program in dual core SMP mode. AARCH32 program
debugging can also be used in the following two settings

1. Refer to Figure 4-34 to disable CPU1 setting for single core mode.
2. Refer to Figure 4-38 to disable the CPU SMP for AMP mode.
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2 Debug Configurations

 [£] 6DB Nuvoton Nu-Link Debugging
[£] Debug_rtthread_aarch32_smp_lite.clf
3 Launch Group

Filter matched 10 of 11 items

o x

Create, manage, and run configurations
CEeEX BT~ Name: | Debug_rtthread_aarch32_smp._ite.clf
[typefitter text ] Main | %% Debugger| g Startup| & Seurce| [ Common

[5] C/C++ Application Open0CD Setup

[T] C/C++ Attach to Application Start OpenOCD locally

[5] C/C++ Container Launcher

5] C/Ce+ Pastmorterm Debugger Executable | ${openocd_nulink path}/epenecd_cmsis-dap.ere Variables...

[T] C/C++ Remote Application GDB port: 3333

Cij C/C++ Unit

[£] 6DB Hardware Debugging Tenetport: (a1 |

Config options:

ot msis-dap.cfg -f ./scripts/targ: 1oMA3SDT.cfg

Allocate console for OpenOCD Allocate console for the telnet connection

GDB Client Setup

Executable: || C:\Program Files (x26)\Nuvoten Tools\Toolchain\AArchéd bare-metal target\gee-arm-8.3-2019.03-1686-mingw32-zarchd-elf\bin\aarch6d-elf-gdb.exe | Browse...| | Variables

3333

Other options: |

Client port:

Commands: [ set mem inaccessible-by-default off

Remote Target
Host name or IP address: | localhost

Port number: 3333

[ Force thread list update on suspend
Restore defaults

Revert Apply

@

Figure 4-40 Locating the AARCH64 GDB Executable

2 Debug Configurations

[] ©/C++ Attach to Application
[£] C/C++ Container Launcher
[E] ©/C++ Postmortem Debugger
[E] ©/C++ Remote Application
Cif C/C++ Unit
[£] GD8 Hardware Debugging
v [€] GDB Nuveton Nu-Link Debugging
[T Debug_rithread_aarch32_smp_lite.elf
@ Launch Group

a X
Create, manage, and run configurations
[FeERX BV~ Name: |Debug_rtthread_aarch32_smp_lite.clf
[type filter text [ Main | %5 Debugger | - Startup | - Source| ] Common
[E] €/C++ Application Initialization Commands ~

monitor seript ../seripts/board/numicroMA33D1_DDR3_256MB_1066MBPS_WINBOND.cfg

[ Enable ARM semihosting
Erase chip

Chip Series: | NuMicro A35
Write' Configh: Ox | FFFFFFFF | Configh: Ox | FFFFFFFF

Config2: Ox FFFFFFFF  Config3: Ox FFFFFFFF

Load Symbaols and Executable

oad symbols
(® Use project binary:  rithread_aarch32_smp_lite.elf
O Use file: Workspace.. File System,
Symbolsoffset (hed: ||
Load executable to flash
Use project binary:  rithread_aarch32_smp_lite.elf
Use file: Workspace... | | File System...
Executable offset ihes)
oad executable to memory
(® Use project binary:  rithread_aarch32_smp_lite.elf
(O Use file: Workspace... File System...
Executable offset (hex):
Run/Restart Commands
[ Pre-run/Restart reset Type: |init | (ahways executed at Restart)
[ Set program counter at (hex):
[ Set breakpoint at: main

[ Continue

Figure 4-41 The First Time to Enter the Debug Mode Settings
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& Debug Configurations =] x
Create, manage, and run configurations ﬁ\.
FeExX av- Name: |Debug_ithread_sarch2_smp_lite.cf

I ||| B Main [ % Debugger | Startup| % Source| 1 Commen
[T] C/C++ Application Initialization Commands
[£) C/C-+ Attach o Applcation Tlintial Reset_Type | e
T C/Co+ Container Launcher
[E] C/C++ Postmonem Debugger
[E] €/C-+ Remote Application
Cif ©/C-= Unit
[£] GO Hardware Debugging

« [£] GOB Huvoton Nu-Link Debugging || T
[ Debug_rtthresd_sarch32_smp lite.elf ERsc iy
& Launch Group Chip Series: | NuMicro A35

Write Configlt G FFFFFFFF Configl: Ox FFFFFFFF Config2: Ox FFFFFFFF Cenfig3: 0x FFFFFFFF

Load Symbols and Executzble
[ Load symbols
(@ Use project binary: rithread_sarch32_smp_lite.elf
O Usefile: Workspace. File System...
Symbols offsetthe: | |
Load executable to flash
Use project binary:  rithread_aarch32_smp_lite.etf

Usefile: Workspace..  File System...

[(Load executable to memory
Use project binary:  rithread_sarch32_smp_lite.elf

Use file: Workspace..  File System..

Run/Restart Commands

[ Pre-run/Restart reset Type: init
] Set program counter at (hex):

] 5t breakpoint at main

[ Continue

Restore defaults «

Revert Apply
Filter matched 10 of 11 items. -

Figure 4-42 The Second Time to Enter the Debug Mode Settings

4§ Debug 32 5 Project Explorer B %|i» 8§ = O = B (%= Variables g Breakpoi o i B, Modules Disassembly 53 7
Debug_rtthread_aarch32_smp _lite.elf [GDE Nuvoton Nu-Link Debugging] » spel2c30:  ldr r1, [pc, #204] ; 0xB0P12d04 <stack_setup+Gs
v B gihiead 2aich3? s liie olf 80812c34:  ldr re, [ri]
£® Thread 211 (Name: ma35d1.cpul, state: debug-request) (Suspended:UsErRI 8eel2c3s:  cmp re, #8
— 3 88@12c3c:  blxne r@
= 80012c40: b @xB8@812c2c <secondary_loop>
= ma35d1_write_pmic_data() at drv_sys_i2c0.c:232 0xB004621¢ A35 Cored normal_setup: ySoor
= ma35di_set_cpu_voltage() at drv_sys_i2c0.c:279 (xB004621 ¢ se@12c44: bl ex8eel2cce <stack_setup>
= nu_clock raise() at drv_sys.c:160 0x800467e4 80912c48:  mov re, #8
= tt_hw_board_init() at drv_common.c:263 0x80046c28 80@12cdc:  ldr rl, [pc, #188] ; @xB80012des <stack_setup+72
itthread startup() at components.c:226 0xB001077c 80812c50: ldr rz, [pc, #18@] ; exB8e@l2déc <stack_setup+76.
bss_loop:
88@12c54:  cmp rl, r2
w @ Thread £2 2 (Name: ma35d1.cpul, state: debug-request) (Suspended : Conta 88812c58: strec r@, [ri], #4
secondary_loop() at start_gcc.5:117 (xB0012c30 88@12c5c:  bee @x88812c54 <bss_loop>
5 openocd_cmsis-dsp.exe A35 Corel 80012c60:  mrc 15, 8, rl, crl, cre, {1}
] aarchid-ch-gdb.exe 88@12c64:  mov re, #64 ; Bx40
geb. 80B12c68:  orr rl, rl, r@

Figure 4-43 AARCH32 Program Debugging
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4.10.7 System Registers Access

When entering the debug mode, we can open the Registers View in the bottom of Debug perspective.
The Registers view lists information about the registers in a selected stack frame. Some system registers
are listed after general registers.

) Console !} Registers 52 [£] Problems () Bxecutables G Debugger Console  [J Memory
Name Value
11 va2g {d = {f = {0x0, 0D}, u = {3
1l w30 {d = {f = {0x0, 0xD}, u = {Oxb
14 vat {d = {f = {OxTHAFFFFRFTFFFE, Ou
4l fpsr 00
1t fper 00
14 ELR_ELT 0xd1£76b8c95e4404a
1l ESR_EL1 08
134 SPSR_EL1 0x600001d3
1! ELR EL2 Ox13d3fb96aalafd3s
14 ESR_EL2 042311160
11} SPSR_EL2 0x12085000
154 ELR_EL3 0x80008170
1l ESR_EL3 0xeDc05203
1§t} SPSR_EL3 Ox1dl3
1§t IFSR32_EL2 0x123b
14 FARELT 0x824b1f1100000004
158 FAR_EL2 0xa301f4291d254101
1ilf FAR_EL3 00
1t HPFAR_EL2 Dx5b12380
138 ISR_ELY 0x0
154 VBAR_EL1 00
111 VBAR EL2 0xc490c22220394520
1t VBAR_EL3 Dx5Ffc0B0D
<

Figure 4-44 System Register View

If there are no system registers user want to access in the list, please select the debugger console and
enter the following command.

1. Read system register : monitor aarch64 mrs [register name]
2. Write system register : monitor aarch64 msr [register name] [value]

The execution result will be displayed in the console window.

& Console i!i Registers [2] Problems (3 Exscutables | GR Debugger Console 52 | [ Memory B Console £ | 417 Registers [2] Problems () Bxecutables [ Debugger Console  [J Memory

Debug_rtthread_aarch32_smp_lite.elf [GDB Nuvaton Nu-Link Debugging] C:\Program Files (x86)\Nuvatc  Debug_rtthread_sarch32_smp_lite.elf [GDE Nuvoton Nu-Link Debugging]
GNU gdb (GNU Toolchain for the A-profile Architecture 8.3-2819.83 (arm-rel-8.7 EH;; rﬁ E;;;g
Copyright (C) 2018 Free Software Foundation, Inc. (114) ri2 (/32)
License GPLv3+: GNU GPL version 3 or later <http://gnu.org/licenses/gpl.html> (115) sp (/32)
This is free software: you are free to change and redistribute it. (116) 1r (/32)
There is NO WARRANTY, to the extent permitted by law. (117) pe (/32)
Type "show copying” and "show warranty” for details. (118) cpsr (/32)
This GDB was configured as "--host=i686-wE4-mingw32 --target=aarch64-elf”. (119) IFSR (/32)
Type "show configuration” for configuration details. (128) DFAR (/32)
For bug reporting instructions, please see: (121) ISR (/32)
<https://bugs.linaro.org/>. (122) vBAR (/32)
Find the GDB manual and other documentation rescurces online at: ¥

<http://www.gnu.org/software/gdb/documentation/>. Eii; :%é: Ej;i;

(125) TTBRL (/64)
(126) TTBCR (/32)
(127) MPIDR (/32)

For help, type "help”.
Type "apropos word” to search for commands related to "word”.
ine; does not match this frame.

VBAR_EL3 [11_118_1106_0068_808]: GxG08808005Tco56
.None =8xbffsl =8b819111111111110869601 16111111111118088901

Figure 4-45 Use Command to Access System Registers
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5 Q&A
1. Q: Can we simultaneously debug on Eclipse, Keil and lar?
A: No, we must stop the debug mode on Eclipse first. Then we can debug on another IDE.

2.  Q: Can we simultaneously debug on Eclipse and use the Nuvoton development tools, such as
ICP Programming tool?

A: No, we must stop the debug mode on Eclipse first. Then we can use them and vice versa.
3. Q: How many breakpoints and watchpoints are supported?

A: It depends on the hardware. For MO chips, the supported number of breakpoints and
watchpoints is 4 and 2, respectively. For M4 chips, the supported number of breakpoints and
watchpoints is 6 and 4, respectively. For M23 chips, the supported number of breakpoints and
watchpoints is 4 and 4, respectively. For now, we do not support flash breakpoints.

4. Q: How to update firmware for Nu-Link?
A: Please use ICP Programming tool or Keil to update firmware.
5. Q: How to change Flash and RAM size after projects are created?

A: Please find and open the Id script in the Id scripts folder. From there, we can change Flash
and RAM size.

6. Q: Why can the application not enter the debug mode?

A: Firstly, we must install all the stuff by following the previously mentioned steps. Then check
the following list:

- Leave the previous debug mode first if exists.
- Flash and RAM size must be correct.

- OpenOCD should not be launched before debugging. To check that, please go to
Windows Task Manager or System Monitor. If an OpenOCD process has already been
running, please end the process.

- The target chip should not be held by other tools or IDE.
- The Config options field of the Debugger tab must be correct.

- In the Startup tab, the Initilal Reset type should be init. The Pre-run/Restart rest
type should be init.

- The Eclipse preferences must be correct. Please refer to the previous discussion.
- Upgrade Nu-Link firmware and USB driver to the latest one.

- Check whether the executable has been downloaded to the target chip correctly.
- Check SP. If it is wrong, please assign it to the correct location.

- Write a correct Config value into the target chip.

- If the operating system is Windows 7, please use USB 2.0 port, instead of USB 3.0
port.

- The project path must not contain any special character or whitespace, such as
#$& .{}.

- Restart the computer.
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7. Q: How to add udev rules for Nu-Link on GNU/Linux?

A: When accessing target chips via Nu-Link, GNU/Linux requires the USB permission. We can
get the permission by adding udev rules for Nu-Link. Here are the steps to do that:

- Add the User to the plugdev Group. Type the command in the Terminal:
sudo useradd -G plugdev $USER

- Add Nu-Link to udev. Type the commands in the Terminal:
cd /etc/udev/rules.d and sudo gedit 10-openocd-nulink.rules

- Add the following text to the file

Text Editor Ty @) 11:34 %

@ rules.d Q | [BE
H © Recent Name A  Size Type Modified
E £ Home 10-openocd-nulink.rules 320 bytes Text 11:31
ﬁ [ Desktop —  9%-vmware-scsiudev.rules 341 bytes Text Dec 20 2016
[ Documents % 10-openocd-nulink.rules (fetc/udev/rules.d) - gedit
'E ¥ Downloads Open v  [#
Music .
4 nulink_usb.c E 10-openocd-nulink.rules x 10-openocd-nulink.rules *
I3 Pictures IATTRS{1dProduct}=="511b", ATTRS{idvendor}=="0416", MODE="@666", GROUP="plugdev"
- IATTRS{idProduct}= , ATTRS{idVendor}=="8416", MODE="0666", GROUP="plugdev"
Wl Videos IATTRS{idProduct}= , ATTRS{idvendor}=="8416", MODE="0666", GROUP="plugdev"
- IATTRS{1dProduct}=="5200", ATTRS{idvendor}=="8416", MODE="0666", GROUP="plugdev"
W) Trash
g Network
© cDROM -
., s
— Computer
[a] Floppy Disk
© Uubuntu16.0... | &
E Connect to Server
PlainText ¥  Tab width:8 ~ Ln 4, Col 80 v INS

0

"10-openocd-nulink.rules” selected (320 bytes)

Figure 5-1 Adding Udev Rules

- Reloaded the new udev rules by entering the command in the Terminal:

sudo udevadm trigger
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8. Q: How to edit string substitution for openocd_nulink_path?

A: The openocd_nulink_path string stores where the OpenOCD executable resides. After
upgrading NuEclipse, the string may keep the previous OpenOCD path. To fix it, click Window
> Preferences, the Preferences wizard appears. Go to Run/Debug > String Substituion.
Find and edit the openocd_nulink_path to the new OpenOCD path.

& Preferences O >

|t)‘PEﬁ|tErtE=¢ String Substitution =1 - 8

General A
C/C++
Changelog Variable Value Description Contributed By New...

Create and configure string substitution variables.

Docker openocd_nulink_executa... openocd.exe com.nuvoton.... Edit

Help openocd_nulink_path C:/Program Files ... com.nuvoton.... |
Install/Update Remave
Library Hover -
Mylyn

Oomph

Remote Development

RPM

~ Run/Debug

Console
External Tools
Launching
Open0OCD Nu-Link
Peripherals views

Perspectives

String Substitution

Yiew Management

View Performance
SWTChart Extensions
Team

Terminal
TextMate
Tracing

Walidatinn

® Igl |¢| Cancel

Figure 5-2 Preferences for String Substitution
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9. Q: Why does Eclipse fail to update or install new software packs on Windows?

A: One of possible reasons is that the write permission for Windows folders is denied. We
need to find the correct folder and allow the write permission. On Windows, the location where
we place software packs is C:\Program Files (x86)\Nuvoton Tools\Packages.

10. Q: How to adjust output voltage of Nu-Link2?

A: Upgrade the NuLink2 firmware greater than version v3.08.7249, open NU_CFG.TXT file in
pop-up "NuMicro MCU" disk, you will see some options in NU_CFG.TXT.

Set CMSIS-DAP=1 then re-plug in USB cable, it presents one more interface HID_CMSIS-
DAP, this is handy if you want to use CMSIS-DAP protocol.

Set LEVEL=3 then re-plug in USB cable, it presents one of output voltage, this is handy if you
want to use 5V voltage.

[Power Control]
LEVEL=3
; Default I/0 voltage (Level(O: 1.8V, Lewvell: 2.5V, Level2: 3.3V, Level3: 5V)

[Interface configuration]
CMSIS-DAP=1

;0 disable

;1 enable

Figure 5-3 More Options for NuLink2
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6 REVISION HISTORY

Date Revision Description
2017.03.31 0.01.000 Alpha version released.
2017.06.30 1.01.000 Beta version released.
2018.09.15 1.01.013 Official version released.
2018.11.30 1.01.014 1. Supported NUCS05. _ _
2. Updated the new project wizard.
2019.08.09 1.01.015 Supported M031 ,M261 and M480LD.
2020.03.06 1.01.016 Supported MO31BT, NUC1311, M2354 and M479.
2020.09.30 1.01.017 Supported M030G, M071, MOA21, M251 and M471.
2021.03.12 1.01.018 Supported MO30GMO031G and NUC1262.
2021.12.01 1.01.019 Supported M460, 194100 and KM1M7.
2022.04.25 1.02.019 Supported MA35D1.
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Important Notice

Nuvoton Products are neither intended nor warranted for usage in systems or equipment, any
malfunction or failure of which may cause loss of human life, bodily injury or severe property
damage. Such applications are deemed, “Insecure Usage”.

Insecure usage includes, but is not limited to: equipment for surgical implementation, atomic
energy control instruments, airplane or spaceship instruments, the control or operation of
dynamic, brake or safety systems designed for vehicular use, traffic signal instruments, all types
of safety devices, and other applications intended to support or sustain life.

All Insecure Usage shall be made at customer’s risk, and in the event that third parties lay claims
to Nuvoton as a result of customer’s Insecure Usage, customer shall indemnify the damages and
liabilities thus incurred by Nuvoton.

Flease note that all data and specifications are subject to change without notice.
All the trademarks of products and companies mentioned in this datasheet belong to their respective owners.
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